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Boot-up Fails to Start 

 

If there are no lights on the computer: 

1. Check the power outlet. 

2. Check to make sure the surge protector is on. 

3. Check the outlet to make sure there is a power source 

 

Monitor doesnôt go on 

1. Make sure the power is on and the outlet is working 

2. If the power go out intermittently, make sure the power cord into the monitor is 

tight 

 

Beep Codes 

Usually there is one beep when you power up the computer. Sometimes there is are no 

beeps but if there are other kinds of beeps, it indicates that something has a problem. 

When you boot up and you hear: 

 

2 ï 4 beeps:   Memory problem 

5 beeps   CPU problem 

6 beeps   mainboard fault 

other beeps    usually mainboard or CPU problem 

 

Fixing with System Restore 

 

If there are problems after you install or uninstall something or download something, you 

want to return to a time when the computer was working better, you may want to use 

system restore. 

1. Restart the computer but keep tapping the F8 key until you see the Windows 

Advanced Options menu 

2. Select Safe Mode 

3. Click the Start Button 

4. Select All Programs 

5. Select Accessories 

6. Select System Tools 

7. Select System Restore 

8. Choose a date before the problem 
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Use System Restore 

After you've decided to use System Restore to revert your system to a previous state, start 

the System Restore Wizard and follow the prompts. To use the System Restore Wizard, 

make sure you're logged on as an administrator, and then follow these steps: 

1. Click Start, point to All Programs, point to Accessories, point to System Tools, and 

then click System Restore.  

2. On the Welcome screen, click Restore my computer to an earlier time, and then click 

Next.  

3. On the Select a Restore Point page, select the date from the calendar that shows the 

point you'd like to restore to, as shown in Figure 2, and then click Next.  

 

Figure 2 

4. On the Confirm Restore Point Selection page, verify that the correct restore point is 

chosen, and then close any open programs.  

5. Click Next if you are ready to proceed or click Back to change the restore point.  

6. The computer will shut down automatically and reboot. On reboot, you'll see the 

Restoration Complete page, and then click OK .  

After reviewing the stability of your system, you can choose another restore point or 

undo this restoration. Just open System Restore and make the appropriate choice. After 

you use System Restore, you'll have an additional task, Undo my last restoration, on the 

System Restore Welcome page. Remember that you'll have to reinstall any programs that 

were installed after the restore point. 

If System Restore doesn't work in Normal Mode, it might work in Safe Mode. To use 

System Restore in Safe Mode, press the F8 key during reboot and choose Safe Mode. 

When your computer starts in either Safe Mode or Normal Mode, System Restore can be 
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used to capture a working previous state. System Restore can't be opened unless the 

system is bootable into one of these modes. 

 
 

Using the System Configuration Utility 

The Windows System Configuration Utility (Msconfig) is a system tool that allows you 

to temporarily change the way Windows starts by disabling startup programs and 

services. We continue the discussion of controlling what programs are allowed to run 

automatically that was begun on the previous page. Here we show how to use Msconfig.  

 

This useful accessory is present in Windows 98/Me/XP but is not listed in the 

Start|Programs menu. The easiest way to access it is to go to Start|Run and enter 

ñmsconfigò (without quotes). 

 

In the window that comes up there is a tab ñStartupò .  

http://vlaurie.com/computers2/Articles/startup.htm
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Click that and you get a list of things that are loaded automatically when you turn on your 

computer. On the left of each entry is a check box. Unchecking this box will remove the 

item from startup at the next boot of your computer. It does NOT remove the item from 

your computer. In the figure below , you can see examples of some unnecessary functions 

such as Quicken "Billminder" that have had their checks removed. The user can still 

choose to run the process whenever desired. Also, if you find that you really do want the 

thing to load at startup, you can always put the check back.  
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Many PC users are reluctant to make use of Msconfig, however, because they are afraid 

of removing something essential. As a general rule, it is my personal opinion that very 

few programs are essential at startup. Every system is different but power management, 

system tray, anti-virus program, and firewall are pretty close to all that many people 

need. I feel that most people will miss nothing by removing any references to Quicken, 

Microsoft Office, RealPlayer, or AOL. Fortunately, there are excellent references that 

explain the function of almost anything you are likely to see in the startup list and give 

recommendations on whether it is safe to remove. Several are given on the previous page. 

In addition to the program modules that may be running at startup, there are a variety of 

processes called "services" and there is also a tab for displaying these, as shown in the 

figure below. 

 

There are many essential Windows services and it is may be convenient to look at only 

the non-Microsoft services. There is a box where a check can be placed by the setting 

"Hide All Microsoft Services", as shown below. 

http://vlaurie.com/computers2/Articles/startup.htm
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You may notice that there are a lot of services from Symantec, which is one reason why 

Norton software (and other anti-virus programs) can measurably slow down your 

machine.(Personally, I disable many of these but the average PC user should not follow 

my example without understanding their function and unless you take all the other 

precautions that I follow to defend my machine.) 

Actually, for the purpose of managing services, it may be better to use the "Services 

Console" and that is discussed on the next page. 

Update from Microsoft 

For systems with Windows XP SP2, Microsoft has released an update to Msconfig. It is 

available here. The update adds a Tools tab that allows further diagnostic tools to be 

launched from Msconfig. The new version of Msconfig is shown below with the new tab 

"Tools" selected. 

http://vlaurie.com/computers2/Articles/defend.htm
http://vlaurie.com/computers2/Articles/defend.htm
http://vlaurie.com/computers2/Articles/defend.htm
http://vlaurie.com/computers2/Articles/services.htm
http://www.microsoft.com/downloads/details.aspx?familyid=9689F6E9-ADED-44B8-BBBB-BEAE1B4A4BC9&displaylang=en


 8 

 
 

 

Troubleshooting Hardware with the Device Manager 

 

Windows XP works with countless different printers, scanners, digital cameras, and other 

devices. It does so with the help of drivers, unique software programs that help your 

operating system communicate with individual pieces of hardware. If your computer 

starts to freeze, crash, or if a hardware device stops working, you can troubleshoot the 

problem with the Device Manager. 

Device Manager shows you how the hardware on your computer is installed and 

configured, and how the hardware interacts with your computer's programs.  

You'll typically use Device Manager to check the status of your hardware and update 

device drivers on your computer. Advanced users who have a thorough understanding of 

computer hardware might also use Device Manager's diagnostic features to resolve 

device conflicts and change resource settings. 

Note  You may need to be logged on as an administrator or be a member of the 

Administrators group in order to use some or all of the features in Device Manager. If 

your computer is connected to a network, network policy settings may also prevent you 

from completing this procedure. 
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To access Device Manager: 

Å Rightïclick My Computer, click Manage, and then click Device Manager. The Device 

Manager opens as shown in Figure 1 below.  

 

Figure 1. Opening the Device Manager  

To view the status of a device: 

1. Open Device Manager.  

2. Doubleïclick the type of device you want to view.  

3. Rightïclick the specific device you want, and then click Properties.  

4. On the General tab, under Device status is a description of the device status, as shown 

in Figure 2 below.  
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Figure 2. Checking status of a device  

If the device is experiencing a problem, youôll see the type of problem in the Device 

status box. You might also see a problem code and number and a suggested solution. If 

you call a support line, this number can be useful for determining and diagnosing the 

problem.  

For information on how to resolve hardware device problems, click Troubleshoot to start 

the Hardware Troubleshooter. 

To install a new driver from Device Manager: 

1. Open Device Manager.  

2. Double-click the type of device you want to update or change.  

3. Right-click the specific device driver you want to update or change.  

4. Click Update Driver to open the Hardware Update Wizard. Follow the wizard 

instructions. 

Note If you install a new driver and your system becomes unstable, you can easily 

uninstall the driver and reinstall the old driver with Driver Rollback. For more 

information, read How to Roll Back a Device Driver. 

To uninstall a device: 
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1. Open Device Manager.  

2. Doubleïclick the type of device that you want to uninstall.  

3. Rightïclick the specific device you want to uninstall, and then click Uninstall.  

4. In the Confirm Device Removal dialog box, click OK .  

When you're done uninstalling the device, turn off your computer, and remove the device 

from the computer. 

Note  Many devices on the market today are Plug and Play, which means when you plug 

the device in your computer will recognize it and automatically prompt you to install the 

drivers you need. You won't usually use Device Manager to uninstall a Plug and Play 

device. Simply disconnect the Plug and Play device from your computer. You might have 

to restart your computer. Check the device manufacturer's instructions for more 

information.     

Product documentation 

For further information about using Device Manager, see the Windows XP 

documentation. To access documentation while using Device Manager, press F1 on your 

keyboard to go directly to the Device Manager section.  

 

 

What To Do When . . .Your PC 
Freezes  

Take These Steps To Defrost Your PC  

You're merrily plugging away at your computer when 

suddenly everything stops. Your system freezes in its tracks 

and, try as you might, you can't get it to respond. You have 

no choice but to shut down the system, which means you'll 

lose all your unsaved data. This is a vexing and all-too-

common computer problem.  

 

Nearly every system will lock up now and again, but if your 

system freezes on a regular basis, you need to pinpoint the cause. This is usually 

easier said than done because there are so many potential sources of PC freezes. 

The freezes could be the result of either a hardware or software problem, or 

possibly a combination of the two. But with a little perseverance and patience 

(and perhaps a lot of experimentation), you should be able to determine what's 

causing your system to misbehave. We'll show you how.  

 

The first thing you should do when your system freezes is restart it and see what 

happens next. Almost no PC is immune to the occasional lockup, so it's entirely 

possible that a particular occurrence may be the exception rather than the rule. If 
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you restart your system and suffer no further freezes or ill effects, chalk it up to 

an unusual glitch, count your blessings, and don't worry about it.  

 

If your system suffers from PC freezes on a regular basis, even after you reboot 

your system, clearly there's something going on inside your PC. If the freezes 

appear to occur randomly and do not seem to be associated with a particular 

program, chances are your PC's hardware is the source of the problem.  

 

Hardware Troubles. There are several ways your system's hardware can 

contribute to or cause PC freezes, so let's look at some likely possibilities and 

ways to resolve them.  

Feeling the heat. Most users don't think about the amount of heat their PCs 

generate. Processors and other components continue to get smaller, and smaller 

chips generate more heat. The heat from your PC's internal components builds up 

inside your system's case, and if it gets too warm in there, your PC can freeze up. 

Your system's internal components may even become damaged if they're exposed 

to too much heat for too long.  

 

You can combat excessive heat problems by making sure your PC is properly 

ventilated. Make sure your system is not pressed against a wall or a desk, as this 

can stifle airflow from the case. Every PC case should have at least one exhaust 

fan, or barring that, a few exhaust holes in the case that hot air can pass through.  

 

One of the easiest ways to reduce heat inside your PC's case is to replace the 

system's IDE (Integrated Device Elec-tronics) and floppy diskette drive ribbon 

cables with rounded cables. Rounded cables usually cost no more than $10 apiece 

and are easy to install. Simply remove the ribbon cables from your hard drive, 

floppy diskette drive, and optical drive (or drives, as the case may be) and plug in 

the rounded cables. Rounded cables allow for much better airflow inside the case, 

which will help keep your components cool.  

 

You also can add a couple of fans to your system's case, which will draw in more 

cool air and help expel hot air. Case fans, like rounded cables, are inexpensive. 

Although a case fan is a little more difficult to install than rounded IDE cables, 

it's not beyond the ability of most users.  

 

Check your drives. If your system is cool and well ventilated, you can assume 

that excess heat is not at fault for your system's freezes. Old drivers can be the 

source of many PC problems, including PC freezes, so it's a good idea to update 

hardware drivers on a regular basis.  

 

Windows users can use the Windows Update feature to check for new hardware 

drivers. You should also go to the support Web page for your PC manufacturer to 

check for driver updates. If you've built your own system, you should stop by the 

Web site of each manufacturer of the major components (including the 
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motherboard, video card, and sound card, if applicable) in your system to check 

for updates.  

 

Maybe it's the memory. Your system's memory is another usual suspect when 

PC freezes occur, so we'll check that next.  

 

If you have two memory modules installed in your system, remove one of them 

and see if your system continues to freeze up. If it does, replace the memory 

module currently in use with the one you removed earlier and try again. If your 

system starts working properly, you know that the memory module you removed 

is at fault and should be replaced. If you still experience PC freezes after using 

both memory modules independently, the freezes are probably the result of 

another problem. It's very unlikely that both memory modules are defective. If 

you only have one memory module installed in your system, you'll have to secure 

a second one to determine if the module you're using is defective. There's also a 

possibility that you're  

simply not using enough memory. If your system only uses 64MB of RAM, and 

you like to run a lot of programs at once, you should expand your memory to at 

least 128MB.  

 

In the best-case scenario, you'll have a spare memory module or a second PC that 

uses the same type of memory as the system you're troubleshooting (for example, 

PC2700 DDRSDRAM as opposed to PC133 memory), but that isn't always the 

case. Try to borrow a compatible memory module if possible, but if that's not an 

option, you may have to buy another memory module and replace the one your 

system is currently using.  

 

Check your power supply. We'll suggest one more hardware-based fix for PC 

freeze-up problems. An inadequate power supply is an oft-overlooked source of 

PC frustrations. Most manufacturers outfit their systems with relatively 

inexpensive OEM power supplies that may have enough juice to power your 

system when they ship it to you, but may not provide enough power when you 

add more components to your system. Underpowering leads to system instability. 

You can buy a beefier, high-quality power supply for about $60 to $90. A 350-

watt power supply should be adequate for most home users, and a 450-watt 

power supply should provide more than enough energy even for extreme 

computing needs.  

 

Software On Ice. Software problems are pretty common events, but most 

software issues usually result in an error message that provides some clue as to 

the nature of the problem. You won't have that advantage when your PC freezes, 

but with a little detective work you can usually pinpoint the software issue that's 

causing your system to lock up.  

 

For example, if you notice that your PC freezes whenever you use a specific 
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application and doesn't freeze when you're not using that application, it's pretty 

clear where the problem lies. The program may have a conflict with another 

program you're running in the background, or it may have a conflict with one of 

your system's hardware components.  

 

When you narrow down freeze-ups to a particular program, you should go to the 

software manufacturer's Web site and download the latest program updates and 

patches for the software. The company's support Web page may also have some 

specific information regarding the program and PC freezes and tips for how to 

resolve the problem. You may also want to shut down programs that are running 

in the background.  

 

Programs running in the background can occasionally interfere with a program 

you're currently using. Close any programs you're not using and see if your 

system remains stable. If it does, you may have to update the programs you 

frequently run in the background, as well as the program that seems to be the 

source of the PC freezes.  

 

There are times when a particular program simply does not get along with a 

specific brand of hardware. As we mentioned earlier, you should update your 

hardware drivers regularly. Hardware and software manufacturers usually have 

information on their support Web pages regarding conflicts between specific 

hardware components and programs and will either provide a downloadable 

patch or step-by-step instructions to resolve those problems.  

 

Keep Your PC Freeze-Free. We've mentioned a couple of maintenance tips 

that may help you resolve PC freezes, namely keeping your hardware drivers and 

software updated. If you do this on a regular basis, you can prevent some PC 

freezes from occurring in the first place. You should also update Windows 

regularly to keep your system in top shape. Go to http://www.microsoft.com and 

click Windows Update on the Microsoft home page. Microsoft will scan your 

system and provide a list of updates you can download for your version of 

Windows.  

 

You should also defragment your PC on a regular basis. Whenever you use your 

PC, your system moves files from place to place on your hard drive. After awhile, 

the files can become so scattered across your hard drive that your PC's 

performance will suffer. Defrag-menting your PC will fix that problem by 

realigning your system's files in a neat and orderly fashion. However, if you use 

Windows XP, your system may, ironically enough, freeze up when you run the 

OS's disk defragmenter utility. If you experience this problem, restart your 

system in safe mode and then run the defragmenter utility.  

 

It seems as though there are nearly limit-less potential causes for PC freezes, 

which is why troubleshooting this problem can make you pull your hair out. 

http://www.microsoft.com/
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Unlike many PC issues, either hardware or software (or a combination of the 

two) can result in a freeze. But you can thaw out PC freezes if you follow our 

tips.  

How to use Windows Task Manager 

This article describes how to use Windows Task Manager. It also explains how to 

perform some frequently used procedures, such as how to start programs, end processes, 

and monitor the computer's performance.  

 

Task Manager displays information about the performance of your computer and the 

programs and processes that are running on your computer. You can use Task Manager to 

start programs, start or end processes, and view a dynamic display of your computer's 

performance.  

 

How to Start Task Manager 

To start Task Manager, do any of the following:  

Å 

Press CTRL+ALT+DELETE, and then click Task Manager.  

 

-or-  

Å 

Press CTRL+SHIFT+ESC.  

 

-or-  

Å Right-click an empty area of the taskbar, and then click Task Manager. 

How to Quit, Switch to, or Start a Program 

The Applications tab displays the status of the programs that are running on the 

computer. To quit, switch to, or start a program, follow these steps:  

1. Click the Applications tab. 

2. 

Do one of the following, as appropriate to the action that you want to perform: 

Å 

Quit a program. 
 

To quit a program, click the program that you want to quit, and then click End 

Task.  

 

NOTE: When you quit a program in this manner, any unsaved data in that program 

is lost. 

Å 

Switch to another program. 
 

To switch to another program, click the program that you want to switch to, and then 

click Switch To. 

Å 
Start a program. 
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To start a program, click New Task. In the Create New Task dialog box, click 

Browse, locate and select the program that you want to start, click Open, and then 

click OK .  

 

NOTE: This procedure is quite similar to starting a program by using the Run 

command on the Start menu.  
 

How to End a Process 

The Processes tab displays information about the processes that are running on the 

computer. To end a process, follow these steps.  

 

NOTE: Proceed with caution when you end a process. If you quit a program in this 

manner, data that has not been saved will be lost. If you end a system process, a system 

component may no longer function properly.  

1. Click the Processes tab. 

2. 

Do one of the following, depending on the action that you want to perform: 

Å 

If you want to end a single process, click the process that you want to end, and then 

click End Process.  

 

-or-  

Å 
If you want to end a process and all processes directly or indirectly related to it, 

right-click the process that you want to end, and then click End Process Tree. 
 

How to Monitor Your Computer's Performance 

Click the Performance tab to view a dynamic overview of the performance of your 

computer, including the following measures:  

Å Graphs for CPU and memory usage. 

Å The total number of handles, threads, and processes that are running. 

Å The total number of kilobytes (KBs) used for physical, kernel, and commit memory. 

 

 

My Printer Won't Print 

There's nothing more frustrating than a printer that botches the job. The printer might 

completely refuse to print a document, or it may print only a portion of the document or 

print a bunch of strange looking symbols instead of the text or graphic you were 

expecting. If you run into printer problems, you probably have to do more fiddling than 

Nero. Look for the following: 

 Is your printer plugged in and turned on? Make sure your printer is plugged in. If 

it is plugged into a power strip or surge suppressor, make sure the power strip or 
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surge suppressor is turned on. If the printer has a power switch or button, turn it 

on. (Many printers have no power switch.) 

 Does your printer have paper? Is the paper tray inserted properly? 

 Is the printer's online light on (not blinking)? If the online light is off or blinking, 

press the On Line button to turn on the light. 

 Is your program set to print to a file? Many Print dialog boxes have a Print to File 

option, which sends the document to a file on your disk instead of to the printer. 

Make sure this option is not checked. 

 Is the print fading? If so, your printer might need a new toner or ink cartridge. If 

your inkjet cartridge has plenty of ink, check your printer manual to determine 

how to clean the print head. Inkjet cartridges have some sensitive areas that you 

should never clean, so be careful. 

 If you have an inkjet printer, check the print head and the area next to the print 

head for tape, and remove the tape. Ink cartridges usually come with two pieces of 

tape on them. You must remove both pieces before installing the cartridge. 

 Is your printer marked as the default printer? In My Computer, double-click the 

Printers icon. Right-click the icon for your printer and make sure that Set as 

Default is checked. If there is no check mark, select Set as Default. 

 Is the printer paused? Double-click the Printer icon in the taskbar, open the Printer 

menu and make sure Pause Printing is not checked. If there is a check mark, click 

Pause Printing. 

 Is the correct printer port selected? In My Computer, double-click the Printers 

icon and double-click the icon for your printer. Click the Details tab and make 

sure the correct printer port is selectedðLPT1 in most cases. 

 Did you get only part of a page? Laser printers are weird; they print an entire page 

at one time, storing the entire page in memory. If the page has a big, complex  

 graphic image or a lot of fonts, the printer might be able to store only a portion of 

the page. The best fix is to get more memory for your printer. The quickest fix is 

to use fewer fonts on the page and try using a less complex graphic image. 

 Is it a printer problem? If you have a standard printer that's connected to your 

computer's parallel port, try printing a simple file list outside of Windows. Go to 

the DOS prompt (choose Start, Programs, MS-DOS prompt or Start, Programs, 

Accessories, MS-DOS prompt), type dir > lpt1  and press Enter. This prints the 

current directory list. If it prints okay, the problem is in the Windows printer 

setup. If the directory does not print or prints incorrectly, the problem probably is 

the printer. (Many printers have a button combination you can press to have the 

printer perform a self test. Check your printer manual.) 

 If error messages keeps popping up on your screen, Windows might be sending 

print instructions to the printer faster than your printer can handle them. In My 

Computer, double-click the Printers icon, right-click your printer's icon, and 

choose Properties. Click the Details tab and increase the number of seconds in the 

Transmission Retry text box. 

 Use the CD that came with the printer or download the printer driver from the 

manufacturer and reinstall the print driver. To do this, plug in the printer, when 

windows finds it as new hardware, put in the cd and follow instructions or if you 

downloaded it, execute the program form your desktop and let it find your printer. 
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How to fix a computer that won't start 

A computer that won't start is frustrating, but the problem is often easy to fix. The steps 

you take to troubleshoot the problem depend on your symptoms. Because different 

problems require different troubleshooting steps, itôs not necessary to read all of these 

instructions. Instead, click on the link that best describes your problem: 

Å You log on by clicking your user account, but then you can't open any programs. 

Å Your computer displays the Windows logo, but fails before you can log on. 

Å You see "Non-system disk or disk error," or a similar message. 

Å Your computer stops immediately after you turn it on or displays nothing on your 

monitor. 

Å Your computer does not turn on. 

Å You need to perform a repair installation of Microsoft Windows XP. 

How to troubleshoot logon problems 

After you click your user account or type your password, immediately press the SHIFT 

key and hold it until your desktop and taskbar are visible. Holding down the SHIFT key 

stops programs from loading automatically, and it is probably one of these programs that 

is causing your problem. Once you are able to log on successfully, you can change the 

programs that run automatically and remove the program that is causing the problem. 

 

How to troubleshoot Windows startup problems 

Sometimes Windows begins to load but then stops responding during the startup process. 

In most cases, the problem is a new piece of hardware, a new program, or a corrupted 

system file. Follow the instructions below to troubleshoot the problem. Try to start your 

computer after each step. Continue to the next step only if Windows continues to fail 

during startup. 

To troubleshoot startup problems 

1. Restart your computer. Immediately after the screen goes blank for the first time, press the 

F8 key repeatedly. The Windows Advanced Options menu appears. If the menu does not 

appear, restart your computer and try again. Use the cursor keys on your keyboard (your 

mouse will not work) to select Last Known Good Configuration, and then press ENTER. 

Windows XP attempts to start. 

http://www.microsoft.com/windowsxp/using/setup/support/nostart.mspx#1
http://www.microsoft.com/windowsxp/using/setup/support/nostart.mspx#2
http://www.microsoft.com/windowsxp/using/setup/support/nostart.mspx#3
http://www.microsoft.com/windowsxp/using/setup/support/nostart.mspx#4
http://www.microsoft.com/windowsxp/using/setup/support/nostart.mspx#4
http://www.microsoft.com/windowsxp/using/setup/support/nostart.mspx#5
http://www.microsoft.com/windowsxp/using/setup/support/nostart.mspx#6
http://www.microsoft.com/windowsxp/using/setup/hwandprograms/autorun.mspx
http://www.microsoft.com/windowsxp/using/setup/hwandprograms/autorun.mspx
http://www.microsoft.com/windowsxp/using/setup/hwandprograms/autorun.mspx
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2. If you recently installed new hardware, shut down your computer and disconnect the 

hardware. Then, restart Windows XP and troubleshoot your hardware to get it working 

properly. 

3. Restart your computer and press F8 again. This time, choose Safe Mode and press ENTER. 

Windows XP attempts to start in Safe Mode, which does not automatically start programs 

and hardware, and displays very primitive graphics. If Windows XP starts successfully in 

Safe Mode, you can remove any programs or updates you have recently installed. Then, 

restart your computer normally.  

 
4. Additional troubleshooting is possible, but it can be complicated and may require 

reinstalling Windows XP. Contact technical support for further troubleshooting assistance. 

Alternatively, you can perform a repair installation of Windows XP. It might solve your 

problem. However, you will lose some settings and need to reinstall updates. 

http://www.microsoft.com/windowsxp/using/setup/support/hardware.mspx
http://www.microsoft.com/windowsxp/using/setup/maintain/removeprog.mspx
http://www.microsoft.com/windowsxp/using/setup/support/options.mspx
http://www.microsoft.com/windowsxp/using/setup/support/nostart.mspx#6
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How to troubleshoot disk errors 

The "Non-system disk or disk error" message means that your computer could not find 

Windows. Follow the steps below and try starting your computer after each step. 

Continue to the next step only if Windows continues to fail during the startup process.  

To troubleshoot disk errors 

1. Your computer might be trying to load Windows from removable media rather than 

from the hard disk inside your computer. Remove any floppy disks, CDs, DVDs, USB 

flash drives, digital cameras, and memory cards.  

2. A portion of your hard disk may be corrupted. You might be able to fix the problem by 

performing a repair installation of Windows XP. 

3. Your hard disk may have failed. Contact technical support for further troubleshooting 

assistance. If your hard disk has failed, it will need to be replaced. After you have 

replaced your hard disk, you should restore your files from a backup. 

Top of page 

How to troubleshoot hardware problems 

If your computer displays an error message within a few seconds of starting, you 

probably have a hardware configuration problem. If you see the Windows logo, you need 

to troubleshoot startup problems. If you see a "Non-system disk or disk error" message, 

you need to troubleshoot disk errors. If you don't even see the startup screen, you likely 

have a hardware problem. 

 

Follow these steps to troubleshoot a hardware problem that prevents your computer from 

starting to load Windows. After each step, restart your computer and attempt to load 

Windows. Continue to the next step only if Windows continues to fail to load. 

http://www.microsoft.com/windowsxp/using/setup/support/nostart.mspx#6
http://www.microsoft.com/windowsxp/using/setup/support/options.mspx
http://www.windowsmarketplace.com/results.aspx?bcatid=586
http://www.microsoft.com/windowsxp/using/setup/maintain/restorefiles.mspx
http://www.microsoft.com/windowsxp/using/setup/support/nostart.mspx#top
http://www.microsoft.com/windowsxp/using/setup/support/nostart.mspx#2
http://www.microsoft.com/windowsxp/using/setup/support/nostart.mspx#3


 21 

To troubleshoot hardware problems 

1. If your computer beeps when you start it but does not display anything on your 

monitor: 

a. Disconnect and reconnect your monitor from your computer. 

b. Verify that your monitor's power cord is connected and that your monitor is turned 

on. 

c. If possible, connect your monitor to a different computer to make sure that your 

monitor works properly. 

d. If your monitor works but your computer beeps and displays nothing, your video 

adapter has probably failed. If your computer is under warranty, contact your computer 

manufacturer for support. If your computer is not under warranty, and you are 

comfortable opening your computer's case and replacing internal hardware, purchase 

and install a compatible replacement video adapter. Otherwise, contact a service center 

for assistance. While replacing a part is a nuisance and may be costly, your documents, 

pictures, and e-mail should be safe and will be available when your computer is fixed. 

2. If you see an error message that indicates that a keyboard is not present or a key is 

stuck, turn off your computer and reconnect your keyboard. If the problem continues, 

replace your keyboard. 

3. Sometimes your computer won't start because your computer is not compatible with a 

hardware accessory. If you have recently added a new hardware accessory, turn your 

computer off, remove the accessory, and restart your computer. 

4. Remove all hardware accessories except your keyboard, mouse, and monitor. If your 

computer starts successfully, shut down Windows, turn off your computer, and add one 

hardware accessory. Then, restart your computer. If your computer fails to start, the 

hardware accessory you most recently added is causing a problem. Remove the 

hardware and contact the hardware vendor for support. You can reconnect other 

hardware accessories. 

5. You may have a loose connector. Turn off your computer, remove all connectors from 

the outside of your computer, and then carefully push the connectors back in. Look for 

stray wires, bent pins, and loosely fitting connectors. 

6. If you are comfortable opening your computer's case, shut down your computer, unplug 

the power, and open your computerôs case. Remove and reconnect all cables. Remove 

and reconnect all cards inside your computer, including your computerôs memory chips. 

Reassemble your computer before attempting to start it again. 

7. If your computer still doesn't start, your motherboard, processor, memory, or graphics 

card may have developed a problem. Contact technical support for further 

troubleshooting assistance. While failed hardware can be frustrating, your documents, 

pictures, and e-mail should be safe and will be there when your computer is fixed. 

Top of page 

http://www.windowsmarketplace.com/results.aspx?bcatid=463
http://www.microsoft.com/windowsxp/using/setup/hwandprograms/installhw.mspx
http://www.microsoft.com/windowsxp/using/setup/support/options.mspx
http://www.microsoft.com/windowsxp/using/setup/support/nostart.mspx#top
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How to troubleshoot a computer that won't turn on 

If your computer does not turn onðyou press the power button and no lights appear, and 

there are no beeps or other soundsðyou should: 

1. Verify that your computer's power cord is connected.  

2. Unplug your computer and connect a different electrical device (such as a lamp, a fan, 

or a radio) into the same electrical outlet. If the device does not work, the problem is 

the electrical outlet, not the computer. 

3. Contact technical support for further troubleshooting assistance. Most likely, the 

computer's power supply has failed. While replacing a part is a nuisance and may be 

costly, your documents, pictures, and e-mail should be safe and will be there when your 

computer is fixed. 

Top of page 

How to perform a repair installation of Windows XP 

Performing a repair installation of Windows XP can fix many serious startup problems. 

While you should not lose any of your important documents, you might lose settings, and 

you will need to reinstall many updates. 

Before performing a repair installation of Windows XP, you should have both your 

Windows XP CD and your product key available. 

To perform a repair installation of Windows XP 

1. Insert your Windows XP CD into your computer. 

2. Restart your computer. If prompted, press a key to start from the CD-ROM. 

http://www.microsoft.com/windowsxp/using/setup/support/options.mspx
http://www.microsoft.com/windowsxp/using/setup/support/nostart.mspx#top
http://update.microsoft.com/microsoftupdate/v6/default.aspx?ln=en-us
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3. When the Welcome to Setup page appears, press ENTER on your keyboard. 

 
4. On the Windows XP Licensing Agreement page, read the licensing agreement. Press the PAGE 

DOWN key to scroll to the bottom of the agreement. Then, press F8. 
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5. When prompted, press R to have Windows XP attempt to repair Windows by reinstalling important 

Windows components. 
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The repair and reinstallation process might take more than an hour. Eventually, Setup 

prompts you to answer questions just as if you were installing Windows XP for the first 

time. For detailed instructions, read Install Windows XP. 

 

 

Installing Windows XP 

 

Installation process 

Installing Windows XP can take up to two hours. To make the process more manageable, 

it has been broken up into several sections. When you are ready, install Windows XP: 

Å Part 1: Begin the installation 

Å Part 2: Continue the installation 

Å Part 3: Complete the installation 

Part 1: Begin the installation 

1. Insert the Windows XP CD into your computer and restart your computer.  

2. If prompted to start from the CD, press SPACEBAR. If you miss the prompt (it only 

appears for a few seconds), restart your computer to try again. 

 
3. Windows XP Setup begins. During this portion of setup, your mouse will not work, so 

you must use the keyboard. On the Welcome to Setup page, press ENTER. 

http://www.microsoft.com/windowsxp/using/setup/winxp/install.mspx
http://www.microsoft.com/windowsxp/using/setup/winxp/install.mspx#begin
http://www.microsoft.com/windowsxp/using/setup/winxp/install.mspx#continue
http://www.microsoft.com/windowsxp/using/setup/winxp/install.mspx#complete
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4. On the Windows XP Licensing Agreement page, read the licensing agreement. Press 

the PAGE DOWN key to scroll to the bottom of the agreement. Then press F8. 

 
5. This page enables you to select the hard disk drive on which Windows XP will be 

installed. Once you complete this step, all data on your hard disk drive will be 

removed and cannot be recovered. It is extremely important that you have a recent 

backup copy of your files before continuing. When you have a backup copy, press D, 

and then press L when prompted. This deletes your existing data. 

6. Press ENTER to select Unpartitioned space, which appears by default. 
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7. Press ENTER again to select Format the partition using the NTFS file system, 

which appears by default. 

 
8. Windows XP erases your hard disk drive using a process called formatting and then 

copies the setup files. You can leave your computer and return in 20 to 30 minutes. 
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Part 2: Continue the installation 
9. Windows XP restarts and then continues with the installation process. From this point 

forward, you can use your mouse. Eventually, the Regional and Language Options 

page appears. Click Next to accept the default settings. If you are multilingual or 

prefer a language other than English, you can change language settings after setup is 

complete. 

 

http://www.microsoft.com/windowsxp/using/setup/winxp/yourlanguage.mspx
http://www.microsoft.com/windowsxp/using/setup/winxp/yourlanguage.mspx
http://www.microsoft.com/windowsxp/using/setup/winxp/yourlanguage.mspx
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10. On the Personalize Your Software page, type your name and your organization 

name. Some programs use this information to automatically fill in your name when 

required. Then, click Next. 

 
11. On the Your Product Key page, type your product key as it appears on your 

Windows XP CD case. The product key is unique for every Windows XP installation. 

Then, click Next. 
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12. On the Computer Name and Administrator Password page, in the Computer name 

box, type a name that uniquely identifies your computer in your house, such as 

FAMILYROOM or TOMS. You cannot use spaces or punctuation. If you connect 

your computer to a network, you will use this computer name to find shared files and 

printers. Type a strong password that you can remember in the Administrator 

password box, and then retype it in the Confirm password box. Write the password 

down and store it in a secure place. Click Next.  
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13. On the Date and Time Settings page, set your computerôs clock. Then, click the 

Time Zone down arrow, and select your time zone. Click Next. 

 
14. Windows XP will spend about a minute configuring your computer. On the 
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Networking Settings page, click Next. 

 
15. On the Workgroup or Computer Domain  page, click Next. 
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Part 3: Complete the installation 
16. Windows XP will spend 20 or 30 minutes configuring your computer and will 

automatically restart when finished. When the Display Settings dialog appears, click 

OK . 

 
17. When the Monitor Settings dialog box appears, click OK . 
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18. The final stage of setup begins. On the Welcome to Microsoft Windows page, click 

Next. 

 
19. On the Help protect your PC page, click Help protect my PC by turning on 

Automatic Updates now. Then, click Next. 
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20. Windows XP will then check if you are connected to the Internet: 

Å If you are connected to the Internet, select the choice that describes your network 

connection on the Will this computer connect to the Internet directly, or through 

a network?  page. If youôre not sure, accept the default selection, and click Next. 
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Å If you use dial-up Internet access, or if Windows XP cannot connect to the Internet, 

you can connect to the Internet after setup is complete. On the How will this 

computer connect to the Internet? page, click Skip. 

  

21. Windows XP Setup displays the Ready to activate Windows? page. If you are 

connected to the Internet, click Yes, and then click Next. If you are not yet connected 

to the Internet, click No, click Next, and then skip to step 24. After setup is complete, 

Windows XP will automatically remind you to activate and register your copy of 

Windows XP. 

http://www.microsoft.com/windowsxp/using/setup/winxp/network.mspx
http://www.microsoft.com/windowsxp/using/setup/winxp/register.mspx
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22. On the Ready to register with Microsoft? page, click Yes, and then click Next. 

 
23. On the Collecting Registration Information  page, complete the form. Then, click 

Next. 
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24. On the Who will use this computer? page, type the name of each person who will 

use the computer. You can use first names only, nicknames, or full names. Then click 

Next. To add users after setup is complete or to specify a password to keep your 

account private, read Create and customize user accounts. 

 

http://www.microsoft.com/windowsxp/using/setup/winxp/accounts.mspx
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25. On the Thank you! page, click Finish. 

 

Congratulations! Windows XP setup is complete. You can log on by clicking your name 

on the logon screen. If youôve installed Windows XP on a new computer or new hard 

disk drive, you can now use the File and Settings Transfer Wizard to copy your important 

data to your computer or hard disk drive.  

After logon, take a few minutes to validate your copy of Windows. Validation gives you 

access to hundreds of free downloads from the Microsoft Download Center. To learn 

about the new features Windows XP provides, click the Start button, click All 

Programs, click Accessories, and then click Tour Windows XP. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

http://www.microsoft.com/windowsxp/using/setup/winxp/migrate.mspx
http://www.microsoft.com/windowsxp/using/setup/winxp/validate.mspx
http://www.microsoft.com/downloads/
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 THE WINDOWS DESKTOP AND FUNCTIONS 
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Click the start button to get the main menu. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



 42 

CREATING A SHORTCUT ON THE DESKTOP 

 

 
 

To create a shortcut on the Windows XP desktop from the start menu, do the following: 

 

ü Click the Start button 

ü Select All Programs 

ü Click Accessories 

ü Right-click Windows Explorer to open the short cut menu 

ü Click Desktop (to create short cut) 

 

And the shortcut now appears on the desktop! 

 

CUSTOMIZING THE START MENU 

You can customize the Start menu for easy access to your favorite programs. The left side 

of the Start menu is separated into two parts. The programs displayed above the separator 

line comprise the pinned items list; the programs below the separator line comprise the 

frequently used programs list. The programs on the pinned items list remain there and are 

always available. By default, Netscape  and Netscape Mail are currently included, but 
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you can change these to a different browser and e-mail reader. You can also add more 

programs to this list.  

To display a program in the pinned items list:  

1. On the Start menu, click All Programs, then Standard Software.  

2. Right-click the selected program from the Standard Software list. Click Pin to 

Start menu. The program will appear on the Start menu.  

3. You can remove a program from the pinned items list by right-clicking the 

program and then clicking Unpin from Start menu.  

To change your Internet browser and e-mail program:  

1. Right-click the Start menu button, then select Properties. The Taskbar and Start 

Menu properties dialog box will appear.  

2. Select the Start Menu tab. Select the Start menu radio button, then click the 

Customize button. The Customize Start Menu dialog box will appear.  

3. Select the General tab. In the Show on Start menu box, select Internet:  and E-

mail: , then select the appropriate browser or reader from the pull-down menus. 

Click OK.  

NOTE: Changing your Internet and E-mail options in the Start menu does not change the 

behavior of the default browser. 

 

 

To search for a file or folder:  

1. Click Start, and then click Search. 

2. In the Search Companion dialog box, click All files and folders. 

3. Type part or all of the name of the file or folder, or type a word or phrase that is in 

the file. 

4. In the Look in  box, click the drive or drives, folder, or network location that you 

want to search. 

5. Choose one of the following options: 

1. Click When was it modified to look for files that were created or 

modified on or between specific dates. 

2. Click What size is it to look for files that are specific size. 

3. Click More advanced options to specify additional search criteria. 

6. Click Search. 

Show hidden files and folders (XP)  

  Views: 9,502 /  Last Updated: September 21, 2002  
 

Double Click on My Computer. 

 



 44 

 

 
 

Click on Tools > Folder Options... in the menus. 

 

 

 
 

Click on the View tab. 

 

Select Show hidden files and folders under Hidden files and folders. 

 

Click the OK  button. 

 

Note: If you are an advanced user you may want to remove the check from Hide 

protected operating system files. 
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FILES AND FOLDERS 
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To start looking at your files, Click the Start menu, select My Computer and you will see 

the following: 
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ü Click ñShow the contents of this driveò 
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ü Double-click Documents and Settings 

ü Double-click the user folder 

ü Double-click My Documents 

ü Right-click one of the files and click Open 

 

 

WINDOWS TIPS AND TRICKS #1 
 

Shutdown Windows XP Fast 

 

While Windows XP is certainly no slouch in the speed stakes it does, like previous 

versions, have a tendency to drag its heels when it comes to shutting down.  The reason 

for this is that the system has to  close down all of the services running in the 

background.  Unfortunately, they donôt always close down as quickly as they should. To 

give them time to do so, Win 2k is configured to wait a specified period before shutting 

down.  The amount of time given is set in the registry and by modifying it Windows can 

be forced to shutdown more quickly.  This is done as follows: 
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 Speed Up Your Start Menu 
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COPYING Files in Windows XP 
 

To copy files and folders to a CD  

1. Insert a blank, writable CD into the CD recorder. 

 

   

2. Open My Computer.  

 

   

3. Click the files or folders you want to copy to the CD. To select more than one file, 

hold down the CTRL key while you click the files you want. Then, under File 

and Folder Tasks, click Copy this file, Copy this folder, or Copy the selected 

items.  

 

If the files are located in My Pictures, under Picture Tasks, click Copy to CD or 

Copy all items to CD, and then skip to step 5. 

 

   

4. In the Copy Items dialog box, click the CD recording drive, and then click Copy.  

 

   

5. In My Computer, doubleïclick the CD recording drive. Windows displays a 

temporary area where the files are held before they are copied to the CD. Verify 

that the files and folders that you intend to copy to the CD appear under Files 

Ready to be Written to the CD.  

 

   

6. Under CD Writing Tasks , click Write these files to CD. Windows displays the 

CD Writing Wizard. Follow the instructions in the wizard. 
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Notes: 

 To open My Computer, click Start, and then click My Computer.  

 

   

 Do not copy more files to the CD than it will hold. Standard CDs hold up to 650 

megabytes (MB). Highïcapacity CDs hold up to 850 MB.  

 

   

 Be sure that you have enough disk space on your hard disk to store the temporary 

files that are created during the CD writing process. For a standard CD, Windows 

reserves up to 700 MB of the available free space. For a highïcapacity CD, 

Windows reserves up to 1 gigabyte (GB) of the available free space.  

 

   

 After you copy files or folders to the CD, it is useful to view the CD to confirm 

that the files are copied. For more information, click Related Topics.  

To stop the CD recorder from automatically ejecting the CD 

1. Open My Computer.  

 

   

2. Rightïclick the CD recording drive, and then click Properties.  

 

   

3. On the Recording tab, clear the Automatically eject the CD after writing check 

box.  
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Copying Files: Copy and Paste Option 

NOTE:  Files copied through Windows Explorer cannot be pasted into files 

(e.g., a Microsoft Word document).  

1. Select the file that you want to copy  

2. From the Edit menu, select Copy  

OR 

Right click » select Copy 

OR 

Press [Ctrl ] + [C] 

3. Select the drive/folder where you want the new copy placed  

4. From the Edit menu, select Paste  

OR 

Right click » select Paste 

OR 

Press [Ctrl ] + [V] 

5. If necessary, adjust the filename (see Renaming Files)  

Copying Files: Drag and Drop Option 

1. Locate the file that you want to copy  

2. Adjust the Folders/Drive listing so you can see the new location 

for the file  

3. Do one of the following:  

a. If the new location is on a different  drive (e.g., hard-drive 

to floppy), drag the file to the new location  

b. If the new location is on the same drive (e.g., hard-drive to 

another location on hard-drive), hold down [Ctrl ] and drag 

the file to the new location  

Moving Files 

Moving files is useful when you want to rearrange your files to create 

better file organization.  

http://www.uwec.edu/help/winxp/exp-files.htm#rename
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To move files, you can use a method similar to copying text. The process 

is similar if you are moving files to the hard-drive or to another floppy 

diskette.  

Moving Files: Cut and Paste Option 

1. Select the file that you want to move  

2. From the Edit menu, select Cut  

OR 

Right click » select Cut 

OR 

Press [Ctrl ] + [X] 

3. Select the drive/folder that you want the file moved to  

4. From the Edit menu, select Paste  

OR 

Right click » select Paste 

OR 

Press [Ctrl ] + [V] 

5. If necessary, adjust the filename (see Renaming Files)  

http://www.uwec.edu/help/winxp/exp-files.htm#rename
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Renaming Files: Menu Option 

1. Select the file that you want to change the name of  

2. From the File menu, select Rename 

3. Type the new file name  

4. Press [Enter]  

Renaming Files: Mouse Option 

1. Select the file that you want to change the name of  

2. Click again on the filename 

OR 

Right click » select Rename 
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A box appears around the filename. 

 

3. Type the new filename  

4. Press [Enter]  

Deleting Files 

Deleting files is an easy way to free up space on your diskettes and disk 

drives. Any file that is no longer needed should be deleted. If you are 

deleting files from a floppy diskette, you need to make sure you are 

deleting the correct file. You will see a confirmation dialog box, but you 

cannot recover the file once it is deleted. If you are deleting files from the 

hard-drive, they are placed in the Recycle Bin and remain there until the 

Recycle Bin is emptied. You can recover files from the Recycle Bin 

before it is emptied. 

Deleting Files: Menu Option 

1. Select the file that you want to delete  

2. From the File menu, select Delete  

3. If you receive a confirmation dialog box, verify that the correct file 

is being deleted:  

a. To confirm, click YES  

b. To cancel, click NO  

Deleting Files: Keyboard Option 

1. Select the file that you want to delete  

2. Press [Delete]  

3. If you receive a confirmation dialog box, verify that the correct file 

is being deleted:  

a. To confirm, click YES  

b. To cancel, click NO  

 

 

http://www.uwec.edu/help/winxp/exp-files.htm#restore
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